Carlson X-Port

Overview
Introduction

Carlson X-Port is a file transfer and data editing utility designed to aid in the processing of
electronic data collection files. Features include raw survey adjustments, coordinate
processing, numerous conversion utilities of coordinate and raw data formats and
communications with all of the popular data collection platforms.
This program reads or creates a raw file (.RW5) that contains lines of data (records) that could
be likened to a surveyor’s field book. You can specify point coordinates, job information, notes,
and the angles and distances that make up traverse or sideshots records. Once the raw data is
created or read, it can be processed/reduced to coordinates that are stored in the current
coordinate file (.CRD file).
The file name extension of the Carlson X-Port raw file is RW5.
When you start the program, a blank editor is shown. You can choose several options from the
File menu to get started. To change the current coordinate file, use the Open or New
Coordinate File commands. Each row of the spreadsheet represents one record of data. There
are 15 types of data records. The type of data record is shown in the first column. Different
record types use different numbers of columns. Whenever the data record type changes
between rows, a record header is added to the spreadsheet that describes each column of
data in the rows that follow it. See the Format of the Raw File section later in this chapter for a
complete list of the supported record header codes and their field headers.

Data Collectors

Communications are supported for the following electronic data collectors:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Carlson SurvCE & SurvStar
C&G Field
Sokkia SDR33 & G2
Leica
Topcon 210/310/220/GPT2000
Nikon
SMI
Geodimeter
TDS

Raw Data

Raw data editing supports the importation of the following formats:
1. Carlson
2. C&G
3. CAiCE (Caltrans Format)
4. AutoDesk Fieldbook
5. Geodimeter
6. Leica
7. Nikon
8. SMI
9. Sokkia/SDR
10. TDS
Raw data editing supports the exportation of the following formats:
1. CAiCE (Caltrans Format)
2. AutoDesk Fieldbook
3. Sokkia/SDR
Coordinate Data

Coordinate editing supports the importation of the following formats:
1.
2.
3.
4.
5.

Text/ASCII (Most common formats)
Geodimeter
Leica
Sokkia/SDR
TDS

Coordinate editing supports the exportation of the following formats:
1.
2.
3.
4.

Text/ASCII (Most common formats)
Geodimeter
Leica
TDS

Survey Adjustment

The following survey adjustment methods are supported:
1.
2.
3.
4.
5.
6.

Angle Balance
Compass
Crandall
Transit
Least Squares (Linear method – Does not support redundant data)
Network Least Squares (Optional)

File Menu
Open RW5 File

Opens any Carlson raw data file (*.RW5) and displays the data in the raw data editor.
New RW5 File

Creates and opens a blank Carlson raw data file (*.RW5) for editing.
Save RW5 File

Saves the existing raw data file (*.RW5) in its current location. If the current file has not been
saved as a result of using the “New RW5 File” function, the user will be prompted for the file
name and location prior to saving the file.
Save RW5 As

Allows the user to save the current raw data file (*.RW5) as a new file name or in a different
location. The current raw data file will be the saved file and the original raw data file will close
and continue to reside in its current location.
Open CRD File

Opens any Carlson coordinate file (*.CRD) and displays the data in the coordinate file editor.
New CRD File

Creates and opens a blank Carlson coordinate file (*.CRD) for editing.
Save CRD File

Saves the existing coordinate file (*.CRD) in its current location. If the current file has not been
saved as a result of using the “New CRD File” function, the user will be prompted for the file
name and location prior to saving the file.
Save CRD As

Allows the user to save the current coordinate file (*.CRD) as a new file name or in a different
location. The current coordinate file will be the saved file and the original coordinate file will
close and continue to reside in its current location.
Print



Raw Data

Opens the Carlson text editor and allows the user to print a report of the raw data.
Print



Coordinates

Opens the Carlson text editor and allows the user to print a report of the coordinate data.

Print



Printer Settings

This function allows the user to specify printing area parameters.
• Use Degree Symbol - This option lets you choose between using the degree circle
symbol and a “d” for degree angles in the report. The “d” can be used for printers that
don't handle the degree circle symbol.
• Use Page Numbers - This option adds a page number to the bottom of each page in the
report.
• Lines/Page - This option specifies the number of lines per page of the report viewer.
• Left Margin - This option specifies the left margin of the report.
• Top Margin - This option specifies the top margin of the report.
• Bottom Margin - This option specifies the bottom margin of the report.
• Text Size - This option specifies text size for the reports.
Exit

This menu item will exit the Carlson X-Port program. If a file has not been saved, the user will
be prompted to do so upon exiting the program.

Edit Menu
Find in RW5 File

Searches for a text string in the raw data file (*.RW5).
Find in CRD File

Searches for a text string in the coordinate data file (*.CRD).
Replace in RW5 File

Searches for a text string in the raw data file (*.RW5) and replaces either all instances or a
single instance of the found text string with the user specified replacement text string.
Replace in CRD File

Searches for a text string in the coordinate data file (*.CRD) and replaces either all instances,
or a single instance of the found text string with the user specified replacement text string.
Delete Row

This function will delete an entire row of data. The current cell selected by the user will
determine the row that gets deleted.
Cut

This function allows the user to remove the data in the selected cell and place the cut value on
the windows clipboard.
Copy

This function will copy the contents of the selected cell to the windows clipboard.
Paste

This function will allow the user to paste any data that may have been cut or copied to the
windows clipboard into the selected cell.

Display Menu
Vertical



Vertical Angle

Displays vertical angles.
Vertical



Zenith Angle

Displays zenith angles.
Vertical



Elevation Difference

Displays the elevation difference between the occupation location and the measured locations
without consideration of the instrument or target heights. Difference displayed is based solely
on the reduction of the slope distance and the zenith angle.
Vertical



None

Removes the vertical circle column from the displayed data.
Distance



Slope

Displays slope distances.
Distance



Horizontal

Displays horizontal distances.

Add Menu
You can add records by pressing the Insert key, pressing the down arrow key from the last line
in the spreadsheet, or by choosing one of the add records from the Add menu of the Raw
Editor.
The types of records are the following:
Traverse

Inserts a traverse record (TR) into the raw data file (*.RW5). When processed, this record
calculates and stores the coordinates for the foresight point. Traversing also moves the setup
by making the traverse foresight point the next occupied point and the traverse occupied point
the next backsight point. The different angle modes are: NE for northeast bearing, SE for
southeast, SW for southwest, NW for northwest, AZ for azimuth, AL for angle left, AR for angle
right, DL for deflection angle left, DR for deflection angle right, and GN for gons. To set the
angle code, pick on the Code down arrow and choose from the list. The horizontal and vertical
angles must be entered as dd.mmss. For example, 45.2305 is 45 degrees, 23 minutes, and 5
seconds. The vertical angle can be shown as vertical angle (0 degrees level), zenith angle (90
degrees level), or elevation difference. The vertical angle mode is set in the Raw Editor Display
menu. The distance mode is also set in the Raw Editor Display menu, as either slope or
horizontal distance. The description field is used as the foresight point description.
Elements of this record include:
1. Occupied Point ID (OcPt)
2. Foresight Point ID (FsPt)
3. Angle Type – NE, SE, SW, NW, AZ, AR, AL, DR, DL, GN (Code)
4. Horizontal Angle Value in dd.mmss (HorzAngle)
5. Distance Value (SlopeDist or HorzDist)
6. Vertical Angle in dd.mmss or Elevation Difference Value (ZenithAng, VertAng or
ElevDiff)
7. Description
Sideshot

Inserts a sideshot record (SS) into the raw data file (*.RW5). The sideshot record is the same
as the traverse record except that sideshot does not move the setup.
Elements of this record include:
1. Occupied Point ID (OcPt)
2. Foresight Point ID (FsPt)
3. Angle Type – NE, SE, SW, NW, AZ, AR, AL, DR, DL, GN (Code)
4. Horizontal Angle Value in dd.mmss (HorzAngle)
5. Distance Value (SlopeDist or HorzDist)
6. Vertical Angle in dd.mmss or Elevation Difference Value (ZenithAng, VertAng or
ElevDiff)
7. Description

Backsight

Inserts a backsight record (BK) into the raw data file (*.RW5). This record should precede any
traverse and sideshot records that use this setup. If no backsight point is entered, the
command turns angles from the backsight azimuth. The Set Azimuth is the circle reading of the
instrument when sighting the backsight. A Set Azimuth of zero is the default.
Elements of this record include:
1. Occupied Point ID (OcPt)
2. Backsight Point ID (BsPt)
3. Backsight Azimuth in dd.mmss (Azi)
4. Set Azimuth in dd.mmss (SetAzi)
Instrument Height

Inserts an instrument height record (HI) into the raw data file (*.RW5). The raw data file, when
viewed by a text editor, will designate this record as “LS”. This record sets the instrument and
rod heights used in elevation calculations. This record should precede any traverse and
sideshot records that you want the heights applied to.
Elements of this record include:
1. Instrument Height (InstHt)
2. Target Height (RodHt)
Elevation

Inserts an elevation record (Z) into the raw data file (*.RW5).
Elements of this record include:
1. Point ID (PntID)
2. Elevation
GPS

Inserts a GPS record into the raw data file (*.RW5).
Elements of this record include:
1. Point ID (PntID)
2. Latitude in dd.mmss
3. Longitude in dd.mmss (Negative for West)
4. WGS84 Ellipsoid Elevation (Elevation)
5. Description (Desc)
Note

Inserts a descriptive note record (DS) into the raw data file (*.RW5). The descriptive note
record is an additional note that appears in the spreadsheet editor and printouts. This record is
not used in processing.
Elements of this record include:
1. Note

Point (To RW5 File)

Inserts a stored coordinate record (PT) into the raw data file (*.RW5). The raw data file, when
viewed by a text editor, will designate this record as “SP”. When processing, this data is stored
as a point in the coordinate file.
Elements of this record include:
1. Point ID (PntID)
2. Northing
3. Easting
4. Elevation
5. Description
Point (To CRD File)

Inserts a stored coordinate record into the coordinate data file (*.CRD).
Elements of this record include:
1. Point ID (PntID)
2. Northing
3. Easting
4. Elevation
5. Description
Reference Azimuth (Network Least Squares Only)

Inserts a known reference azimuth record (AZ) in dd.mmss between two points into the raw
data file (*.RW5). This azimuth will be held and adjusted to during the Network Least Squares
reduction process.
Elements of this record include:
1. Occupied Point ID (OcPt)
2. Foresight Point ID (FsPt)
3. Known Azimuth (Azi)

Control Standard Error (Network Least Squares Only)

Inserts a Control Standard Error record (CSE) into the raw data file (*.RW5). This in-line
standard error record must contain values in all fields. This record will override the project
default control standard errors for all coordinate point records that follow.
•
•
•
•
•

If you want to hold a coordinate value fixed, use the “!” sign for the Standard Error.
If you want to allow the coordinate record to “float”, use the “#” sign.
If you enter a small standard error, the values will contain more weight than if you enter
a large standard error.
A zero value entered for the azimuth record will not allow the azimuth to change during
the adjustment.
To return any standard error back to the project default settings, enter an “*” sign.

Elements of this record include:
1. Northing
2. Easting
3. Elevation
4. Azimuth in seconds (Azimuth(sec))
The Northing, Easting and Elevation standard errors reflect the weight of the coordinate
records that follow this standard error record.
“Azimuth(sec)” is the standard error for azimuth/bearing (direction) records in seconds. For
example, you may enter Reference Azimuth records based on known data or Solar or Polaris
observations. This standard error controls these records.
Setup Standard Error (Network Least Squares Only)

Inserts a Setup Standard Error record (SSE) into the raw data file (*.RW5). This in-line
standard error record must contain values in all fields. This record will override the project
default setup standard errors for all records that contain occupied point, backsight point,
instrument height or target height data that follow.
•
•
•
•
•

If you want to hold a coordinate value fixed, use the “!” sign for the Standard Error.
If you want to allow the coordinate record to “float”, use the “#” sign.
If you enter a small standard error, the values will contain more weight than if you enter
a large standard error.
A zero value entered for an azimuth standard error record will disallow the azimuth to
change during the adjustment.
To return any standard error back to the project default settings, enter an “*” sign.

Elements of this record include:
1. Target Centering (Rod Ctr) error. This value reflects how close you can set the target
prism up over the point.
2. Instrument Centering (Inst Ctr) error. This value reflects how close you can set the
instrument up over the point.
3. Instrument Height (Inst Hgt) standard error. This value reflects how close you can
measure the height of the instrument.
4. Target Height (Rod Hgt) standard error reflects how close you can measure the height
of the target/rod.

Measurement Standard Error (Network Least Squares Only)

Inserts a Measurement Standard Error record (MSE) into the raw data file (*.RW5). This in-line
standard error record must contain values in all fields. This record will override the project
default measurement standard errors for all records that contain horizontal circle, vertical circle,
or distance data that follow.
•
•
•
•
•

If you want to hold a coordinate value fixed, use the “!” sign for the Standard Error.
If you want to allow the coordinate record to “float”, use the “#” sign.
If you enter a small standard error, the values will contain more weight than if you enter
a large standard error.
A zero value entered for an azimuth standard error record will disallow the azimuth to
change during the adjustment.
To return any standard error back to the project default settings, enter an “*” sign.

Elements of this record include:
1. Horizontal Reading Error (HA Rd(sec)) and Vertical Reading Error (VA Rd(sec)). These
values reflect the total station angular reading error in seconds. If you have a 10 second
theodolite, enter a reading error of 10 seconds.
2. Horizontal Pointing Error (HA Pt(sec)) and Vertical Pointing Error (VA Pt(sec)). These
values reflect the total station angular pointing error in seconds. This value is how
accurately the instrument man can point to the target. For example, you may set it
higher in the summer because of the heat waves, or when shooting a prism pole versus
a target mounted on a tripod, or if you are turning “Robotic Sets” versus manual pointing
because robotic instruments lock on the targets less accurately than if you pointed
manually.
3. Distance Standard Error (Distance). This value reflects the total station distance reading
standard error.
4. Distance PPM Standard Error (Dist PPM). This value reflects the distance Parts per
Million standard error.

Process (Compute Points) Menu
The commands under the Process (Compute Points) menu provide various methods for
processing the raw file and for storing the calculated points in the coordinate file. The different
types are described separately for each adjustment.
No Adjust

This command processes the raw file and stores the calculated coordinates to the coordinate
file. The name No Adjust means that no angle balance or traverse adjustment will be applied.

The dialog box shown above prompts for the following options:
•
•
•

Report SideShots -This option specifies whether to include the sideshot data in the
process results report.
Correct for Earth Curvature - This adjusts the calculated points for the effect of the
Earth's curvature. Typically this adjustment is small and adjusts the elevation more than
the horizontal.
Scale Factor - This factor is multiplied by the slope distance for the traverse and
sideshot records.

After you pick OK for the first dialog box, a Traverse Points dialog box appears. Enter the
starting and ending point numbers.

The command reads the raw file to set the defaults for these point numbers, which are used to
calculate the closure. The difference between the ending point and the reference closing point
is the closure error. The sum of the traverse distances from the starting to the ending point is
used as the total distance traversed.
After you pick OK for the second dialog box, the program starts processing the raw file from the
top record down. The result is displayed in the standard report viewer, which you can use to
save, print, or draw the report.

Angle Balance

This process command applies an angle balance to the traverse lines when calculating the
coordinates. This command initially displays the same dialog boxes as the No Adjust method.
One additional dialog is shown below.

The angle balance takes the angular error divided by the number of traverse lines and adjusts
the angle of each traverse line by that amount. The angular error is the difference between the
angle balance shot and a reference angle. The angle balance shot is specified as a type AB or
CL+AB record in the raw file. The angle from the angle balance shot is calculated as the angle
from the occupied point to the foresight point. The reference angle can be specified as a
bearing, as an azimuth, or by two point numbers in the dialog box shown. The angle balance
report shows the unadjusted points, the unadjusted closure, the angular error, the adjusted
points, and the adjusted closure. Typically, but not always, applying the angle balance
correction improves the traverse closure.

Compass, Crandall, Transit, Least Squares

These process commands apply the selected rule of Compass, Crandall, Transit, or Least
Squares to the traverse lines when calculating the coordinates. The dialog box is the same for
all these methods.

•
•
•
•
•
•
•
•

Reference Closing Point - This is the field for entering the point number and coordinates
to compare the ending traverse point with. The reference closing point is used to
calculate the closure.
Apply Angle Balance - Applies the Angle Balance method to the traverse lines for
calculating coordinates.
Apply Vertical Adjustment – Adjusts the traverse elevations.
Report SideShots - This option specifies whether to include the sideshot data in the
process results report.
Report Unadjusted Points - Includes the unadjusted points in the report.
Report Point Adjustments - Reports the adjustment of each point.
Correct for Earth Curvature - This adjusts the calculated points for the effect of the
Earth's curvature. Typically this adjustment is small and adjusts the elevation more than
the horizontal.
Scale Factor: This factor is multiplied by the slope distance for the traverse and sideshot
records.

After the command adjusts the traverse, it also recalculates the sideshots. The closure error is
calculated as the difference between the closing shot and a reference point. The closing shot is
specified as a type CL or CL+AB record in the raw file. If no CL record is found in the raw file,
then the command prompts for which traverse shot to use as the closing shot. The foresight
point is used as the closing coordinate. The reference point can be specified by point number
or by entering the northing, easting, and elevation. The process results report shows the
unadjusted points, closure error, adjustments to each traverse point, and adjusted points.

Network Least Squares

The Network Least Squares Adjustment program (NLSA) will perform a mathematically
rigorous least squares adjustment and statistical analysis of a network of raw traverse field
data.
The NLSA program will simultaneously adjust a network of interconnected traverses with any
amount of redundancy. The raw data can contain any combination of traverse (angle and
distance), triangulation (angle only), and trilateration (distance only) measurements. It can also
calculate resections, where any combination of distances and angles can be measured from an
unknown point to known points (points located in the traverse). The raw data does not need to
be in a linear format, and individual traverses do not have to be defined using any special
codes. All measurements will be used in the adjustment.
The NLSA program can adjust both 3D and 2D traverses, as well as 3D traverses that contain
some 2D data. If you have Vertical Adjustment turned ON in the project settings, elevations will
be calculated and adjusted only if there is enough information in the raw data file to do so.
Least squares adjustment is used for elevation adjustment as well as the horizontal
adjustment. To compute elevations the instrument record must have a HI, and the foresight
record must have a rod height, slope distance and vertical angle. A 0.0 (zero) HI or ROD
HEIGHT is valid (only when the field is blank will it be considered a 2D measurement). A 3D
traverse must also have adequate elevation control in order to process the elevations.
Elevation control can be obtained from the Control File, Coordinate records in the raw data file,
or Elevation records in the raw data file.
The NLSA program can also automatically reduce field measurements to State Plane
coordinates in either the NAD 83 or NAD 27 coordinate systems. A grid factor is computed for
each individual line during the reduction. The elevation factor is computed for each individual
line if the data is 3D. If the raw data has only 2D data, the user has the option of defining a
project elevation to be used to compute the elevation factor.
A full statistical report containing the results of the least squares adjustment is produced
reported. Coordinates will be written to the current coordinate (*.CRD) file.
Although the NLSA program does not output the standard “Error of Closure” statement, it
produces statistical information that allows a much more effective way to evaluate the strength
of your traverses, and the precision of your measurements.
Raw Data Files

The NLSA program processes Carlson raw data files (*.RW5). Measurement, coordinate,
elevation and direction (Brg/Az) records will be recognized. Scale factor records are not
processed because the software calculates the state plane scale factors automatically.
Standard Error Records in the Raw Data File

Although you can set default standard errors for the various types of measurements in the
project settings, standard errors can also be placed directly into the raw data file. You can add
Standard Error records by selecting the “Add” menu followed by selecting one of the standard
error types. (See the “Add Menu” section of this document for a full description of the available
standard errors.)

If you do not have standard errors defined in the raw data file, the standard errors in the project
settings will be applied to the entire file.
Importing Coordinate Records into the Raw Data File

You may also add coordinate point records into the raw data file. Under the “Add” menu item,
select “Point (To RW5 File)”.
This function allows you to bring in control points and assign them Coordinate Standard Error
values that are different than the project default settings.
In order to process a raw data file, you must have at least one coordinate point record in either
the raw data file.
If you are putting control points in a Raw Data File, you may also put the standard error records
in the file (as described above). If you do not include a SE record the standard error will be
assigned from the X, Y, and Z standard errors from the project settings dialog box.

Network Least Squares Settings

The project settings dialog has four tabs; Coordinate System, Adjustment, Standard Errors and
Output Options.
Coordinate System

You have the following options on the “Coordinate System” tab of the “Network Least Squares
Settings” dialog box shown below.

•
•

•
•

Coordinate System - You can select Local (assumed coordinate system), SPC 1983
(State Plane NAD83), or SPC 1927 (State Plane NAD27).
Zone – If you choose SPC 1983 or SPC 1927, you will be allowed to select the State and
Zone you are in. The grid scale factor is computed for each measured line using the
method described in section 4.2 of NPAA Manual NOS NGS 5, “State Plane Coordinate
System of 1983”, by James E. Stem.
Horizontal Units – This applies to the input/output of coordinate values (Meters, US Feet,
or International Feet).
Compute Elevation Factor From - When you select SPC 1983 or SPC 1927, in order to
calculate the combined scale factor so as to adjust distances to sea-level, you will be
given the choice of either entering a “Project Elevation”, or using the elevations of the
calculated coordinate points. If you are reducing a 2D network, you will want to select
“Project Elevation” since none of the calculated points will have elevations. For most
survey projects it is sufficient to use an approximate elevation such as could be obtained
from a Quad Sheet. For 3D networks the elevation factor is computed for each individual
line.

Adjustment

You have the following options on the “Adjustment” tab of the “Network Least Squares
Settings” dialog box shown below.

Least Squares Adjustment Options
• Maximum Iterations - Number of iterations allowed for convergence.
• Convergence Threshold - Stop when the corrections to the adjustment are less than this
value.
• Apply Horizontal Adjustment - Check box for adjustment of North/East values.
• Apply Vertical Adjustment - Check box for adjustment of elevations.
• Enable sideshots for relative error ellipses – Check box for sideshot relative error
ellipses.
You can adjust either horizontal and vertical data, horizontal data only, vertical data only, or no
adjustment.
If Vertical Adjustment is not checked, elevations will not be calculated.
Raw Data Preprocessing
• Apply Curvature and Refraction Corrections - Do you wish to correct for curvature and
refraction? We recommend that the curvature and refraction correction always be
applied.
• Horz.Dist Tolerance - Display a warning if the difference between highest and lowest
horizontal distance component exceeds this value.
• Vert. Dist Tolerance - Display a warning if the difference between highest and lowest
vertical difference component exceeds this value.
• Horz. Angle Tolerance - Display a warning if the difference between the highest and
lowest horizontal angle exceeds this value.

When multiple angles or distances are measured to a point, a single average angle, horizontal
distance component and vertical difference component will be calculated for use in the least
squares adjustment. You may set the tolerances so that you are warned if any angle or
distance exceeds these values. Tolerance warnings will be shown in the report after
processing the data.

Standard Errors

Standard errors are basically realistic errors you would expect to obtain based on the type
equipment and field procedures you are using to take your measurements. For example, if you
are using a 5 second theodolite, you could expect the angles to be measured within +/- 5
seconds (Reading error). The following options are available on the “Standard Errors” tab of
the “Network Least Squares Settings” dialog box shown below.

•
•
•
•
•
•
•
•
•
•
•
•
•

Distance Standard Error – Precision of distance measurements, obtain from EDM specs.
How precise are your distance measurements (obtain from EDM specs).
PPM – Parts per Million, Obtain from EDM specs.
Horizontal Pointing (sec) – Atmospheric conditions, optics, experience and care taken by
instrument operator.
Horizontal Reading (sec) – Precision of horizontal angle measurements, obtain from
theodolite specs.
Vertical Pointing (sec) – Atmospheric conditions, optics, experience and care taken by
instrument operator.
Vertical Reading (sec) – Precision of vertical angle measurements, obtain from
theodolite specs.
Target Centering – How close can you set the target (prism) over the point?
Instrument Centering – How close can you set the instrument over the point?
Target Height – How close can you measure the height of the target?
Instrument Height – How close can you measure the height of the instrument?
Direction (Azimuth) Standard Error (sec) – How precise are your bearing / azimuth
records?
North Coordinate, East Coordinate – How precise are your horizontal coordinate
records?

The Distance, Angle Reading (Vertical and Horizontal) and PPM settings should be based on
the equipment being used. Check the published specifications for the total station being used.
Survey methods should also be taken into account when setting standard errors. For example,
you might set the Target Centering standard error higher when you are sighting a held prism
pole than you would if you were sighting a prism set on a tripod.
The settings from this dialog box will be used for the project default settings. These default
standard errors can be overridden for specific measurements by placing SE records directly
into the Raw Data File (see the above section on raw data files).
If the report generated when you process the data shows that generally you have consistently
high Standard Residuals for a particular measurement value (angles, distances, etc.), then
there is the chance that you have selected standard errors that are better than your instrument
and methods can obtain. (See explanation of report file).

Output Options:

The following options are available on the “Output Options” tab of the “Network Least Squares
Settings” dialog box shown below. These settings apply to the output of data to the report and
coordinate files.

•
•
•
•
•
•
•

North/East Precision - Select how many places you want to see after the decimal.
Elevation Precision - Select how many places you want to see after the decimal.
Distance Precision - Select how many places you want to see after the decimal.
Direction Precision - Angular output of nearest second, tenth of second, or hundredth of
second for directions (Azimuths or Bearings)
Direction Format - Reported directions can be output in Bearing or Azimuth
Coordinate Display – Reported coordinates can be output in either North-East or EastNorth.
Null Elevation - Value to be reported for elevations that were not calculated.

Coordinate File Output

The calculated coordinates will be written directly to the current coordinate file.
If coordinate points already exist in the coordinate file, they will be overwritten and updated
with the new coordinate values.
Process Network

If there is a problem with the reduction, you will be shown error messages that will help you
track down the problem.
The data is preprocessed to calculate averaged angles and distances for sets of data. For a
given setup, all multiple angles and distances to a point will be averaged prior to the
adjustment. The standard error as set in the Project Settings dialog box is the standard error
for a single measurement. Since the average of multiple measurements is more precise than a
single measurement the standard error for the averaged measurement is computed using the
standard deviation of the mean formula.
During the preprocessing, approximate coordinate values for each point will also be calculated.
This saves the user from having to come up with a list of approximate coordinate values prior
to processing.
Sideshots are separated from the raw data and processed after the adjustment.
If the raw data processes properly, a report file will be displayed and the coordinate file will be
populated with the adjusted coordinates.

Network Least Squares Results Dialog

Once the adjustment is complete, the following dialog box will be presented.

Inverse Button

The “Inverse” button is found on the main window. This button is only active after a network
has been processed successfully. This button can be used to obtain the bearing and distance
between any two points in the network. Additionally the standard deviation of the bearing and
distance between the two points is displayed. This information can be used to determine the
relative precision between any two points in the network.

If you need to certify as to the “Positional Tolerances” of your monuments, as per the ALTA
Standards, use this function to determine these values.

For example, if you must certify that all monuments have a positional tolerance of no more than
0.07 feet, inverse between the monuments in as many combinations as you deem necessary
and make note of the standard deviations of the distances. If none of them are larger than 0.07
feet, you have met the standards.

Relative Error Ellipse

Report the relative error ellipse from one point to another.

Report

The report file will be shown in a text window so you can analyze the data. You can pick the
“Printer” icon if you want a hardcopy.
The first section of the report displays the primary settings used when the project was adjusted.
The second section of the report displays warning and error messages generated during the
preprocessing of the raw data. The primary messages displayed will be warnings when
multiple angles, horizontal distances, and vertical differences exceed the tolerance settings as
set in the project settings. The low and high measurement and the difference are displayed.

Unadjusted Observations
The next four sections list the reduced and averaged measurements that contribute to the
network. When multiple measurements are used, the standard error for the averaged
measurement will be computed using the average of the mean formula.
The first of the four sections is a list of the control coordinates used in the network adjustment.
These coordinates would have been read from the raw data file. Notice that the standard errors
for the control points are displayed.
The second of the four measurement sections shows the azimuths and azimuth standard
errors used in the adjustment. Azimuths can only be defined as a direction record in the raw
data file.
The third of the four measurement sections shows the distances and distance standard errors
used in the adjustment. These distances are horizontal distances derived from all slope
distance and vertical angles for that line, including all foresight and backsight distances. The
standard error settings used to calculate the final distance standard error include the distance
standard error, the PPM standard error, the target centering standard error and the instrument
centering standard errors. The techniques and formulas used to calculate the final distance
standard error are found in section 6.12 of the textbook “Adjustment Computations, Statistics
and Least Squares in Surveying and GIS”, by Paul Wolf and Charles Ghilani.
The fourth of the four measurement sections shows the angles and angle standard errors used
in the adjustment. These angles are the averaged angle value for all the multiple angles
collected. The standard error settings used to calculate the final angle standard error include
the pointing standard error, the reading standard error, the target centering standard error and
the instrument centering standard errors. The techniques and formulas used to calculate the

final angle standard error are found in section 6.2 of the textbook “Adjustment Computations,
Statistics and Least Squares in Surveying and GIS”, by Paul Wolf and Charles Ghilani.

Adjusted Coordinates
If the adjustment of the network converges the next section displays a list of the final adjusted
coordinates and the computed standard X, Y standard error. An interpretation of the meaning
of the X, Y standard error, is that there is a 68% probability that the adjusted X, Y is within plus
or minus the standard error of the X, Y of its true value.
The next section displays the error ellipses for the adjusted coordinates. The error ellipse is a
truer representation of the error of the point than the X, Y standard error. The error ellipses are
calculated to a 95% confidence interval. The error ellipse axis is larger than the X, Y standard
errors since the error ellipses in this report are calculated at a 95% probability level. The
maximum error axis direction is along the axis of the semi-major axis. The direction of the
minimum error axis direction is along the semi-minor axis and is perpendicular to the semimajor axis. If a point is located from a variety of stations, you will see that the error ellipse will
approach a circle, which is the strongest geometric shape.

Adjusted Observations
The next three sections list the adjusted horizontal distance, horizontal angle, and azimuth
measurements. In addition to the adjusted measurement the, residual, the standard residual
and the standard deviation of the adjusted measurement is displayed. The residual is defined
as the difference between the unadjusted measurement and the adjusted measurement. The
residual is one of the most useful and intuitive measures displayed in the report. Large
residuals in relation to the standards of the survey are indications of problems with the data.
The standard residual is the a priori standard error divided by the computed standard deviation
of a measurement. A standard residual of 1 indicates that the adjusted measurement is
consistent with the standard errors defined for the measurement. One or a few measurements
having high standard residuals, in relation to the rest of the standard residuals, may be an
indication of a blunder in the survey. When all standard residuals are consistently large there is
likely an inconsistency in the a priori standard errors and the adjustment. In other words the
standard errors defined for the project are too small, in relation to the survey methods used.
The standard deviation of the measurement means that there is a 68% probability that the
adjusted measurement is within plus or minus the standard deviation of the measurement’s
true value.

Statistics
The next section displays some statistical measures of the adjustment including the number of
iterations needed for the solution to converge, the degrees of freedom of the network, the
reference variance, the standard error of unit weight, and the results of a Chi-square test.
The degree of freedom is an indication of how many redundant measurements are in the
survey. Degree of freedom is defined as the number of measurements in excess of the number
of measurements necessary to solve the network.
The standard error of unit weight relates to the overall adjustment and not an individual
measurement. A value of one indicates that the results of the adjustment are consistent with a
priori standard errors. The reference variance is the standard error of unit weight squared.

The chi-square test is a test of the “goodness” of fit of the adjustment. It is not an absolute test
of the accuracy of the survey. The a priori standard errors which are defined in the project
settings dialog box or with the SE record in the raw data file are used to determine the weights
of the measurements. These standard errors can also be looked at as an estimate of how
accurately the measurements were made. The chi-square test merely tests whether the results
of the adjusted measurements are consistent with the a priori standard errors. Notice that if you
change the project standard errors and then reprocess the survey the results of the chi-square
test change.

Sideshots
The next section displays the computed sideshots of the network. Sideshots are filtered out of
the network adjustment as part of the preprocessing process. Least squares adjustment
requires a lot of computer resources. Sideshots are filtered out to minimize the computer
resources needed in a large network adjustment. The sideshots are computed from the final
adjusted network points. The results of the sideshot computations are the same whether they
are reduced as part of the least squares adjustment or from the final adjusted coordinates.
The next part of the report displays the results of the vertical adjustment. The horizontal and
the vertical adjustments are separate least squares adjustment processes. As long as there
are redundant vertical measurements the vertical component of the network will also be
reduced and adjusted using least squares.
The first section displays the fixed vertical benchmarks used in the vertical adjustment. These
points are fixed and will not be adjusted vertically. Next, is listed the points that will be adjusted
as part of the vertical adjustment. The following section displays the measurements used in the
adjustment. The measurements consist of the vertical elevation difference between points in
vertical adjustment. The lengths between these points are used to determine the weights in the
vertical adjustment. Longer length lines are weighted less in the vertical adjustment than
shorter length lines.

LEAST SQUARES VERTICAL ADJUSTMENT REPORT
The next section displays the adjusted elevations and the computed standard deviations of the
computed elevations. Following the adjusted elevation section is a section displaying the final
adjusted elevation difference measurements and their residuals. Finally, the computed
sideshot elevations are displayed.
State Plane Reduction Report File
When reducing to a state plane coordinate system, there will be additional information
displayed in the report file.
First, notice the heading of the report. The heading indicates that the project is being reduced
into the Florida east zone of the 1983 State Plane Coordinate System. The heading shows that
the elevation factor is computed based on a project elevation of 20 meters:
Tue Jul 16 21:25:34 2002
Input File: D:\lsdata\cgstar\CGSTAR.RW5
Curvature, refraction correction: ON
Maximum iterations: 10 , Convergence Limit: 0.001000
1983 State Plane Coordinates, zone:0901 Florida East
Elevation factor computed from project elevation,5.000000.
Elevation Units: Meters
Horizontal Units: Meters

The first distance listing in the Unadjusted Observation section of the report shows the
unadjusted ground distances:
Distances:
From Sta.
1
1
2
2
3
3
20
21
4
5
10
10
11
12

14 Observations
To Sta.
Ground Dist.
5
290.450
2
292.214
6
52.388
3
324.186
4
275.603
20
134.663
21
116.073
22
50.115
5
309.647
10
129.985
11
126.010
15
10.000
12
129.426
3
144.651

StErr
0.0116
0.0116
0.0124
0.0113
0.0115
0.0147
0.0146
0.0144
0.0116
0.0126
0.0125
0.0142
0.0126
0.0126

There is a new section displaying the reduced unadjusted grid distances. The grid factor, the
elevation factor, and the combined factor used to reduce the ground distance to a grid distance
are included in the listing:
Grid Distances:
14 Observations
From Sta.
To Sta.
Grid Dist.
1
5
290.458
1
2
292.221
2
3
324.195
3
4
275.611
3
20
134.666
20
21
116.076
4
5
309.655
5
10
129.989
10
11
126.014
11
12
129.429
12
3
144.655

Grid Factor
1.00002753
1.00002801
1.00002802
1.00002752
1.00002773
1.00002759
1.00002725
1.00002734
1.00002755
1.00002775
1.00002782

Z Factor
Combined Factor
0.99999922 1.00002674
0.99999922 1.00002723
0.99999922 1.00002723
0.99999922 1.00002674
0.99999922 1.00002694
0.99999922 1.00002680
0.99999922 1.00002646
0.99999922 1.00002656
0.99999922 1.00002677
0.99999922 1.00002697
0.99999922 1.00002703

In the Adjusted Coordinates section of the report there is a new section displaying the latitude
and longitude of the final adjusted points. Additionally the convergence angle, the grid factor,
the elevation factor, and the combined factor are displayed for each point:
Adjusted Geographic Coordinates
Sta.
Latitude
Longitude
1
25-54'18.04854"N 80-09'50.01222"W
5
25-54'22.19238"N 80-09'59.38867"W
2
25-54'24.71981"N 80-09'42.54113"W
3
25-54'32.95530"N 80-09'49.80362"W
4
25-54'32.25098"N 80-09'59.67503"W
20
25-54'36.61787"N 80-09'52.45127"W
21
25-54'39.78404"N 80-09'54.71776"W
10
25-54'25.52242"N 80-09'56.51499"W
11
25-54'24.81748"N 80-09'52.05512"W
12
25-54'28.26890"N 80-09'49.39720"W

Conv. Ang.
000-21'55"
000-21'51"
000-21'58"
000-21'55"
000-21'51"
000-21'54"
000-21'53"
000-21'52"
000-21'54"
000-21'55"

Grid Factor Z Factor
1.00002780
0.99999922
1.00002726
0.99999922
1.00002823
0.99999922
1.00002781
0.99999922
1.00002724
0.99999922
1.00002765
0.99999922
1.00002752
0.99999922
1.00002742
0.99999922
1.00002768
0.99999922
1.00002783
0.99999922

Combined Factor
1.00002701
1.00002647
1.00002744
1.00002702
1.00002645
1.00002687
1.00002674
1.00002664
1.00002689
1.00002705

The remainder of the report is the same as the Local Coordinate System report that follows.

Sample Network Least Squares Adjustment Local Coordinate System Report
===============================
LEAST SQUARES ADJUSTMENT REPORT
===============================
Tue Jul 16 21:03:16 2002
Input File: D:\lsdata\cgstar\CGSTAR.CGR
Output File: D:\lsdata\cgstar\CGSTAR.RPT
Curvature, refraction correction: ON
Maximum iterations: 10 , Convergence Limit: 0.001000
Local Coordinate System, Scale Factor: 1.000000
Horizontal Units: Meters
Warning, Angle spread exceeds tolerance.
Inst. at 1, Backsight 5, Foresight 2
Low Angle: 109-19'10", High Angle: 109-19'17",

Difference:

000-00'07"

Warning, Angle spread exceeds tolerance.
Inst. at 2, Backsight 1, Foresight 6
Low Angle: 190-32'02", High Angle: 190-32'10",

Difference:

000-00'08"

Warning, Angle spread exceeds tolerance.
Inst. at 2, Backsight 1, Foresight 3
Low Angle: 096-03'48", High Angle: 096-03'56",

Difference:

000-00'08"

Warning, Angle spread exceeds tolerance.
Inst. at 3, Backsight 2, Foresight 4
Low Angle: 124-03'50", High Angle: 124-03'56",

Difference:

000-00'06"

Warning, Angle spread exceeds tolerance.
Inst. at 5, Backsight 4, Foresight 10
Low Angle: 039-26'35", High Angle: 039-26'45",

Difference:

000-00'10"

Warning, Angle spread exceeds tolerance.
Inst. at 10, Backsight 5, Foresight 11
Low Angle: 241-56'23", High Angle: 241-56'35",

Difference:

000-00'12"

Warning, Angle spread exceeds tolerance.
Inst. at 11, Backsight 10, Foresight 12
Low Angle: 114-56'20", High Angle: 114-56'34",

Difference:

000-00'14"

Warning, Angle spread exceeds tolerance.
Inst. at 12, Backsight 11, Foresight 3
Low Angle: 140-39'18", High Angle: 140-39'31",

Difference:

000-00'13"

Warning, Angle spread exceeds tolerance.
Inst. at 5, Backsight 4, Foresight 1
Low Angle: 117-30'35", High Angle: 117-30'50",

Difference:

000-00'15"

Warning, Vertical distance between 1 and 5 exceeds tolerance.
Low Vert. Distance:
7.492, High Vert. Distance:
7.523,
Warning, Horizontal distance between 2 and 3 exceeds tolerance.
Low Distance: 324.154, High Distance: 324.195, Difference:

Difference:

0.031

0.042

Warning, Vertical distance between 2 and 3 exceeds tolerance.
Low Vert. Distance:
6.612, High Vert. Distance:
8.357,

Difference:

1.745

Warning, Vertical distance between 3 and 4 exceeds tolerance.
Low Vert. Distance:
11.459, High Vert. Distance:
11.516,

Difference:

0.057

Warning, Vertical distance between 4 and 5 exceeds tolerance.
Low Vert. Distance:
4.340, High Vert. Distance:
4.375,

Difference:

0.035

Warning, Horizontal distance between 12 and 3 exceeds tolerance.
Low Distance: 144.641, High Distance: 144.661, Difference:

0.020

HORIZONTAL ADJUSTMENT REPORT
============================

Unadjusted Observations
=======================
Control Coordinates:
1 Observations
Sta.
N:
E:
1
10000.000
10000.000
Distances:
From Sta.
1
1
2
2
3
3
20
21
4
5
10
10
11
12
Angles:
BS Sta.
5
1
1
2
2
3
20
3
4
5
5
10
11
12
4
Azimuths:
Occ. Sta.
1

14 Observations
To Sta.
5
2
6
3
4
20
21
22
5
10
11
15
12
3
15 Observations
Occ. Sta.
FS
1
2
2
3
3
20
21
4
5
10
10
11
12
3
5

Dist.
290.450
292.214
52.388
324.186
275.603
134.663
116.073
50.115
309.647
129.985
126.010
10.000
129.426
144.651

Sta.
2
6
3
4
20
21
22
5
10
11
15
12
3
2
1

StErr N:
0.0010

StErr
0.0116
0.0116
0.0124
0.0113
0.0115
0.0147
0.0146
0.0144
0.0116
0.0126
0.0125
0.0142
0.0126
0.0126

Angle
109-19'13"
190-32'06"
096-03'52"
124-03'53"
185-23'56"
180-15'26"
183-26'45"
093-02'12"
039-26'40"
241-56'29"
056-23'10"
114-56'27"
140-39'24"
325-54'30"
117-30'42"

1 Observations
FS Sta.
Bearing
2
N 45-00'00"E

StErr E:
0.0010

StErr (Sec.)
13.0
41.0
12.8
13.1
20.6
22.5
12.2
13.2
19.3
8.6
12.2
8.6
8.6
8.6
13.0

StErr (Sec.)
5.0

Adjusted Coordinates
====================
Adjusted Local Coordinates
Sta.
N:
1
10000.000
5
10125.859
2
10206.625
3
10458.769
4
10435.346
20
10571.010
21
10668.042
10
10228.844
11
10207.941
12
10314.625

E:
10000.000
9738.222
10206.625
10002.881
9728.285
9928.475
9864.776
9817.550
9941.814
10015.112

StErr N:
StErr E:
0.0010
0.0010
0.0153
0.0102
0.0089
0.0089
0.0111
0.0183
0.0183
0.0194
0.0191
0.0268
0.0274
0.0376
0.0152
0.0135
0.0143
0.0134
0.0143
0.0140

Adjusted Coordinates Error Ellipses 95% CI
Sta.
Semi Major
Semi Minor
Axis
Axis
1
0.004
0.004
5
0.067
0.043
2
0.045
0.031
3
0.081
0.046
4
0.104
0.050
20
0.119
0.078
21
0.174
0.102
10
0.075
0.046
11
0.068
0.050
12
0.064
0.058

Max. Error Az.
N
N
N
N
N
N
N
N
N
N

45-00'00"E
10-51'15"E
45-00'00"E
77-38'20"E
47-34'08"E
72-08'02"E
64-12'51"E
37-10'13"E
38-56'28"E
38-41'29"E

Adjusted Observations
=====================
Adjusted Distances
From Sta. To Sta.
1
5
1
2
2
3
3
4
3
20
20
21
4
5
5
10
10
11
11
12
12
3
Adjusted Angles
BS Sta. Occ. Sta.
5
1
1
2
2
3
2
3
3
20
3
4
4
5
5
10
10
11
11
12
12
3
4
5
Adjusted Azimuths
Occ. Sta. FS Sta.
1
2

Distance
290.4621
292.2123
324.1736
275.5934
134.6627
116.0727
309.6469
129.9959
126.0102
129.4370
144.6625

FS Sta.
2
3
4
20
21
5
10
11
12
3
2
1

Bearing
N 45-00'00"E

Residual
0.0119
-0.0012
-0.0126
-0.0101
-0.0000
-0.0000
0.0003
0.0107
0.0000
0.0110
0.0118

StdRes.
1.0
0.1
1.1
0.9
0.0
0.0
0.0
0.9
0.0
0.9
0.9

Angle
109-19'21"
096-03'36"
124-03'52"
185-23'56"
180-15'26"
093-02'11"
039-26'44"
241-56'32"
114-56'33"
140-39'32"
325-54'36"
117-31'00"

StdDev
0.0104
0.0104
0.0103
0.0102
0.0147
0.0146
0.0102
0.0107
0.0108
0.0108
0.0113

Residual
7.4
-15.5
-1.5
0.0
0.0
-0.1
4.1
2.5
6.0
7.5
6.5
17.2

Residual StdRes
-0.0
0.0

StdRes
0.6
1.2
0.1
0.0
0.0
0.0
0.2
0.3
0.7
0.9
0.8
1.3

StdDev(Sec)
9.5
8.5
9.1
20.6
22.5
8.9
10.4
8.2
8.1
7.8
7.2
9.3

StdDev(Sec.)
5.0

Statistics
==========
Solution converged in 2 iterations
Degrees of freedom:6
Reference variance:1.83
Standard error unit Weight: +/-1.35
Passed the Chi-Square test at the 95% significance level
0.680 <= 10.955 <= 18.550

Sideshots
=========
From
2
21
10

To
6
22
15

Bearing
N 55-32'06"E
N 29-50'17"W
N 86-00'27"W

Dist.
52.388
50.115
10.000

N
10236.272
10711.514
10229.540

E

StDev. N

StDev. E

10249.817 0.0114 0.0136
9839.841 0.0396 0.0383
9807.574 0.0135 0.0196

LEAST SQUARES VERTICAL ADJUSTMENT REPORT
Tue Jul 16 21:03:16 2002
Input File: D:\lsdata\cgstar\CGSTAR.CGR
Output File: D:\lsdata\cgstar\CGSTAR.RPT
Curvature, refraction correction: ON

FIXED VERTICAL BENCHMARKS
Station

Elevation
900.0000

1

POINTS TO BE ADJUSTED
Station
5,2,3,4,10,11,12

MEASUREMENT SUMMARY
From
1
1
2
3
4
5
10
11
12

To

Elev. Diff.
(unadjusted)
7.5040
7.5659
6.9833
-11.4907
4.3557
2.2647
1.0938
0.3836
3.3600

5
2
3
4
5
10
11
12
3

Length
(weights)
290.4502
292.2135
324.1861
275.6035
309.6466
129.9852
126.0102
129.4259
144.6507

ADJUSTED ELEVATIONS
Station
1
5
2
3
4
10
11
12

Adjusted Elev
900.0000
907.4862
907.5838
914.5869
903.1124
909.7506
910.8441
911.2273

Standard Dev.
0.00000
0.02438
0.02443
0.02832
0.03091
0.02836
0.03016
0.03026

ADJUSTED MEASUREMENT SUMMARY
From
1
1
2
3
4
5
10
11
12

Sideshots
Station
20
21
22
15

To

Elev. Diff.
(adjusted)
7.4862
7.5838
7.0031
-11.4745
4.3739
2.2644
1.0935
0.3832
3.3596

5
2
3
4
5
10
11
12
3

Elevation
901.918
911.404
910.293
909.751

Residuals
-0.0178
0.0179
0.0199
0.0162
0.0182
-0.0003
-0.0003
-0.0003
-0.0004

GPS

The process GPS routine allows you to reduce the GPS records that reside in a raw (*.RW5)
file from latitude, longitude and WGS84 Ellipsoid Height to State Plane or local coordinates.
Elements of the GPS record include:
1. Point ID (PntID)
2. Latitude in dd.mmss
3. Longitude in dd.mmss (Negative for West)
4. WGS84 Ellipsoid Elevation (Elevation)
5. Description (Desc)
The first dialog that you will receive from this routine is shown below.

Projection Type
Defines the datum coordinate system to be used for converting the Latitude,
Longitude and WGS84 Ellipsoid height collected from the GPS receiver into Cartesian
coordinates.
For the United States two separate horizontal control systems have been developed by the
Federal Government, State Plane1927 and State Plane 1983.
For International use, the UTM (Universal Transverse and Mercator System) should be
selected.

Zone
For State Plane projections, you must select the correct state zone that you are working in. For
UTM, the Automatic Zone option will have the program automatically use the correct UTM zone
for your location. Otherwise for UTM, you can manually set a specific UTM zone. This manual
option applies to working on the border between zones and you want to force the program to
always use one of those zones.

Transformation
The transformation in the Align Local Coordinates command can either be by plane similarity or
rigid body methods. Both methods use a best-fit least squares transformation. The difference is
that the rigid body method does a transformation with a translation and rotation and without a
scale. The plane similarity does a rotation, translation and scale. This option only applies when
two or more points are used in Align Local Coordinates.
One Point Alignment Azimuth
This option applies to the rotation when using one point in Align Local Coordinates. For this
alignment method, the state plane coordinate is translated to the local coordinate. Then the
rotation can use either the state plane grid or the geodetic as north. No scale is applied in this
transformation. The state plane and geodetic true north diverge slightly in the east and west
edges of the state plane zone. This option allows you to choose which north to use.
Geoid To Apply
This option will account for the geoid undulation in determining the orthometric elevation of the
measurement. The definition of the geoid model as currently adopted by the National Geodetic
Survey is the equipotential surface of the Earth's gravity field which best fits, in a least squares
sense, global mean sea level. Orthometric elevation measurements are used in survey
calculations. In order to convert ellipsoid heights (He) as measured by GPS into orthometric
elevations (Eo), you must provide for a correction between the GPS-measured ellipsoid
(reference ellipsoid) and a constant level gravitational surface, the geoid. This correction is the
geoid undulation (Ug). The formula is He=Eo + Ug.
The Geoid models are essentially large elevation difference models in grid format. X-Port has
two geoid models available.
Geoid99 covers the United States at 1 minute grid intervals.
EGM96 covers the entire globe at 15 minute intervals.
These Geoid models are huge and take a lot of disk space and memory. The Geoid model files
are not installed automatically and instead need to be installed separately from the CD.
X-Port applies the Geoid model by subtracting the Geoid undulation from the GPS elevation.
The resulting elevation is then used and displayed. In practice, the Geoid model is most
applicable to two types of alignment scenarios. One of these types is when setting up the base
over a known point and having no alignment control points. The other is when there is one
alignment control point. When using multiple alignment control points, the Geoid model is not
as important because X-Port can model the elevation difference which can generally pick up
the local Geoid undulation.

Units
Coordinates can be reduced into one of three available units, Metric, US Feet or International
Feet.

Scale Factor
After converting the LAT/LONG from the GPS records to state plane coordinates and applying
the coordinate alignment (Localization) file, the Project Scale Factor is applied as the final
adjustment to the coordinates. This adjustment is used on the X,Y and not the Z. The
Project Scale Factor is applied by dividing the distance between the coordinate and a base
point by the Project Scale Factor. The coordinate is then set by starting from the base point
and moving in the direction to the coordinate for the adjusted distance. The base point is the
first point in alignment (Localization) file. If there are no points specified in the alignment
(Localization) file, then 0,0 is used as base point.
The second dialog shown below will prompt if an alignment (Localization) file is to be used
during the process. This file is typically created by SurvCE using the Localization routine or by
Tsunami using the Align to Local Coordinates routine. This file (*.DAT) contains the parameters
to transform the derived State Plane coordinates to the defined local coordinates.

At the end of the process, the coordinates will be written to the current coordinate (*.CRD) file
and a report will be presented in the Carlson test editor for saving or printing purposes.

Tools Menu
Data Transfer

 SurvCE/SurvStar/G2

Make sure the data collector is connected to the Local PC.
In the SurvCE or G2 software, execute the command “Data Transfer” from the “File” menu.

In Carlson X-Port, choose Tools  Data Transfer  SurvCE/SurvStar/G2. The following dialog
will be presented as communications are trying to be established.

Once connected the “SurvCom” dialog for data transfer will be presented as shown below.

If the communication parameters are set correctly, a connection will be made and the directory
listing from SurvCE or G2 will be retrieved.
Note: If a connection is not made, the SurvCom dialog shown above will open anyway. Choose
the options button and adjust the COM port and/or baud rate settings to match those of the
data collector and press the Connect button to try again.
1. Connect – Connects the data collector to the local PC.
2. Transfer - Used to transfer files. The list on the left shows files on the PC. The list on the
right shows files on the data collector. To move files from one to another, highlight the
files and press the Transfer button.
3. Set Path - This command allows you to set the path on either the local PC or the remote
data collector as illustrated below. Type in the path you wish to change to, choose Local
PC or Remote Machine and then press OK. You may also change the path by
navigating the directory structure shown in the main window of the SurvCom program.

4. Make Dir - This command allows you to create a directory on either the Local PC of the
Remote Machine as illustrated below. Type in a directory name you want to create,
choose Local PC or Remote Machine and then press OK. If you enter an invalid
directory name, it will not be created. Invalid directory names are determined by the
operating system.

5. Delete - This command allows you to delete files and empty directories.
6. Rename – This command allows you to rename a file as needed.
7. Options - This command allows you to set various options as illustrated and outlined
below.

•
•
•
•
•
•
•

Com Port - You must select which COM port on the PC to use.
File Mask - You must select a file filtering syntax. *.* will show all files.
Directory Sort - You must select how to sort the list of files.
Display Special Files - Toggle whether or not you should see special files.
Confirm Overwrite - Toggle whether of not you want the file transfer program to
have you confirm overwriting of files.
Baud Rate - You must choose the baud rate for transferring data.
Protect Remote Files - Toggle whether or not you want to protect files on the
mobile device.

8. Set Geoid - This command will prompt you to select a directory with geoid grids, and
enter the longitude and latitude near the center of your job. The geoid grids are a
separate install program located on the SurvCE CD or are available via download from
Carlson Software at http;//update.carlsonsw.com/public.
9. F2F conv - This command will copy a field to finish field to finish file (.FLD) to the data
collector and convert it to the (.FCL) format used by SurvCE.
10. Exit - This command will exit the data transfer program.

Data Transfer



Sokkia/SDR

This command applies to the Sokkia SDR-20, SDR-22, SDR-31 and SDR-33 as well as other
collectors that have SDR format transfer, such as the Trimble and C&G.

Downloading

1. From the SDR data collector, go to the Communications menu from the Func menu.
Choose Data Format SDR.
2. Press the Com function key, and then select all options to match the settings you will set
in Carlson X-Port.
3. Press OK when all the communication settings are set.
4. Press the Optns function key, highlight current view and set it to Yes with the right arrow
key. Make sure that all other options are set to No, then press OK.
5. Press the Send function key, then choose Select Jobs. From the list of jobs, highlight the
job to transfer and set it to Yes with the right arrow key.
6. Switch to Carlson X-Port.
7. Pick Data Collectors from the Tools menu and choose Sokkia SDR.
8. Check that the COM port and baud rate are set correctly.
9. Click the Download button and within 10 seconds go back to the SDR and press OK.
The file should transfer.

The SDR format contains both coordinate and raw data. The coordinate data is converted to a
CRD file and the raw data is converted to a RW5 file. The original SDR transfer file is stored on
the computer as a SDR file.
When the transfer is complete, the program will ask you for the coordinate file unless you
specified a file name in the dialog box.
The SDR has different modes for storing and transferring data.
In coordinate mode, the download creates points in the CRD file and the RW5 file contains only
some basic header lines.

In the raw data mode, the download creates all the measurement data in the raw file and no
points are created in the CRD file. When you see raw data mode, you will need to run EditProcess Raw File in the Tools menu to calculate the points from the raw data.
The third mode in the SDR creates both raw data in the RW5 file and points in the CRD file.
The Include Time Stamps in Notes option sets whether all the date-time records for each point
are included in the RW5 file as description records. The Include Point Attributes in Notes option
will store SDR code 13(AT) codes to the point note (.NOT) for the coordinate file.
Uploading

Point data from the CRD file can be uploaded into the SDR.
1. Begin at the Communications menu from the SDR Func menu.
2. Choose Data Format SDR. Switch to Carlson X-Port and choose Sokkia SDR from the
Data Transfer command in the Tools menu.
3. Check that the COM port and baud rate are set correctly.
4. In the Sokkia/SDR Data Collection dialog box, pick the Select File button next to the
CRD File edit box and choose the CRD file to send.
5. Click the Upload button. A Sokkia/SDR Options dialog box appears for setting the job
parameters for the file to be created on the collector.
6. Choose the Distance Unit that matches your coordinate file (meters, US feet, or
7. International feet), change all other options to meet your requirements and click OK.
8. In the dialog box that appears, specify the range of point numbers to upload.
9. Before you click the Start Transfer button for range of points, switch to the SDR and
press the Recv function key. The SDR is now waiting to receive.
10. Return to Carlson X-Port and click Start Transfer on the Points to Transfer dialog box.
The file should transfer.
Receive Sokkia Print File

This command downloads a print report from the SDR data collector. This file is used only for
printing report purposes. This file is not used to generate coordinate files or raw files.
To receive a print file:
1. Choose Data format Printed in the Communications menu from the SDR Func menu.
2. Click the Receive Sokkia Print File button in Carlson X-Port.
3. On the SDR, press the Send Func key and select a job to send. The file is immediately
transferred and displayed in the standard report viewer.
Send Sokkia SDR Data File

This command uploads a Sokkia .SDR or .RAW file to the data collector. If there is not an SDR
file name already entered (at the top of this dialog), then you will be prompted to select either a
(*.SDR) file or a (*.RAW) file to send.

Data Transfer



Geodimeter

This command applies to the Geodimeter 600 and Trimble 5600 total stations.

Downloading

1. From the Geodimeter data collector, go to the file transfer command by pressing the
PRG (Program) key and entering program 54.
2. Choose Imem (option 1) as the source.
3. Choose the file type to send as either Job (measurement data) or Area (point data). The
Geodimeter then prompts for the job name.
4. Enter Serial (option 3) as the destination. A confirmation screen appears showing the
serial port settings. Here are some typical settings: COM=1,8,0,9600
5. Before pressing ENT (enter) key, go to Carlson X-Port and pick Data Collectors from the
Tools menu and choose Geodimeter.
6. Click the Download button and within 15 seconds, go back to the Geodimeter and press
Enter. The file transfer then proceeds.
7. When the transfer is complete, the program prompts for the coordinate file (.CRD) and
raw file (.RW5) to create if you haven't already specified a file name in the dialog box.

Uploading

1. In Carlson X-Port, choose Geodimeter under Data Collectors from the Tools menu.
2. Pick the Select File button next to the CRD File edit box and choose the CRD file to
send.
3. Verify that the COM port and baud rate are set correctly and then click the Upload
button.
4. In the dialog box that appears, specify the range of point numbers to upload.
5. Before clicking OK, go to the Geodimeter data collector and start the file transfer routine
by pressing the PRG key and entering program 54.
6. Choose Serial (option 3) as the source. The Geodimeter displays the serial port settings,
check these values and press enter.
7. Next choose Area (option 2) as the destination, and then enter the job name. The
Geodimeter is now prepared to receive data.
8. In Carlson X-Port, click the OK button for the range of points to send. The file transfer
proceeds.

Data Transfer



Leica

There are two types of Leica transfers: GIF-10 and GeoCom for all other Leica instruments.
The type is set in the Equipment Type field on the main dialog box. For transferring with Leica
instruments, the GeoCom program shows a dialog box of the available COM ports on your
computer. The first time that you transfer to an instrument, you will need to pick the Instruments
button and register the instrument from the list. Pick the Port Settings button to make sure that
the communication settings match the instrument.

Downloading (GeoCom)

1. To download a file with GeoCom, make sure that the instrument is on and connected to
the computer by serial cable and choose Download.
2. In the GeoCom program, open the computer COM port that the instrument is connected
to by picking the '+'.
3. Open the Memory Card and GSI folders.
4. Select the file to transfer and click the OK button.

Uploading (GeoCom)

1. To upload a file with GeoCom, specify the file name to be created on the instrument in
the Leica File field, and choose Upload. The command will prompt for the range of
points to transfer.
2. Enter the range and pick the Start Transfer button. The GeoCom program will start.
3. Open the computer COM port by picking the '+'.
4. Open the Memory Card folder, highlight the GSI folder, and click OK.
5. The upload and download file transfer works with the GIF-10 data collector. The GIF-10
communication settings should be the following:
Baud: 9600
Parity: NONE
Protocol: NONE
Stop Bit: 1 1
End Mark: CR/LF
Connected As: some computers use DCE and others use DTE

Downloading (GIF-10)

1.
2.
3.
4.

From the GIF-10 data collector, run the file transfer command.
In Carlson X-Port, select Data Collectors from the Tools menu, and choose Leica.
Verify that the COM port and baud rate are set correctly.
Click the Download button and within 10 seconds switch back to GIF-10 and select the
file to send. The file transfer should begin.
5. When the transfer is complete, the program will ask you for the CRD file to create unless
you already specified a file name in the dialog box.

Uploading (GIF-10)

1. From the GIF-10 data collector, run the file transfer command.
2. In Carlson X-Port, select Leica under Data Collectors from the Tools menu.
3. In the Leica Data Format Conversion dialog box, specify the job name in the Leica File
field.
4. Pick the Select File button next to the CRD File edit box and choose the CRD file to
send.
5. Check that the COM port and baud rate are set correctly.
6. Click the Upload button.
7. Specify the range of point numbers to upload. Before clicking the OK button for the
range of points, switch to the GIF-10.
8. Start to receive by highlighting Receive and pressing the Run button. The GIF-10 shows
the available job numbers.
9. Use the arrow buttons to choose a job to receive the transfer, then press the Run button.

Data Transfer



Nikon

This command applies to the following Nikon data collectors and total stations:
DR-48
AIMS CE
DTM-300
DTM-310
DTM-400
DTM-500/330/350
DTM-700
DTM-800

Downloading

1. Choose the equipment and data type under the Transfer Type list. Also, check that the
communication and data format settings match your collector.
2. Then, click the Download button and follow the on-screen directions.
3. When the transfer is complete, the program will ask you for the coordinate file (.CRD)
and raw file (.RW5) to create if you haven't already specified a file name in the dialog
box.
4. The original data from the collector is stored in a file name with the same name as the
coordinate file except with a .TRN extension. For example, job5.crd would have job5.trn.

Uploading

1. Pick the Select File button next to the CRD File edit box and choose the CRD file to
send.
2. Check that the COM port and baud rate are set correctly and then click the Upload
button.
3. In the dialog box that appears, specify the range of point numbers to upload.
4. Click the Start Transfer button. The file transfer then proceeds.

Data Transfer



SMI

This command applies to SMI data collectors.

Downloading

1. To send point data from the SMI data collector, go to the file transfer command by typing
[More] [NXT] [TOPC] [COMM].
2. In SMI version 6 or later, type [Job][KERM][SEND].
3. Also in version 6, make sure that first function key reads [NE] and not [XY] in the
[Job][KERM] screen. Otherwise, the coordinate northing and easting will be reversed.
4. Enter the first point to send, followed by the last point to send, but before you press
Enter for the last point, switch to Carlson X-Port. Pick Data Collectors from the Tools
menu and choose SMI.
5. Check that the COM port and baud rate are set correctly.
6. Click the Download button and within 10 seconds switch back to SMI and press Enter to
send the last point.
7. When the transfer is complete, the program will ask you for the coordinate file to create
unless you already specified a file name in the dialog box.
8. To send raw data, use the [Print][Raw] command in SMI then follow the same procedure
used for point data.

Uploading

1. From the SMI data collector, go to the file transfer command by typing [More] [NXT]
[TO48] [COMM].
2. In SMI version 6 or later, type [Job][KERM][RECV].
3. Also in version 6, make sure that first function key reads [NE] and not [XY] in the
[Job][KERM] screen. Otherwise, the coordinate northing and easting will be reversed.
4. Enter the first point to send, followed by the last point to send.
5. Enter the job name, but before you press Enter, switch to Carlson X-Port. Pick Data
Collectors from the Tools menu and choose SMI.
6. In the SMI HP-48 Data Collection dialog box, specify the same job name that you
entered in SMI.
7. Pick the Select File button next to the CRD File edit box and choose the CRD file to
send.
8. Check that the COM port and baud rate are set correctly, then click the Upload button.
9. In the dialog box that appears, specify the range of point numbers to upload.

10. Enter the same range of points that you entered on the SMI.
11. Go back to SMI and press Enter for job name, then switch back to Carlson XPort and
press the OK button for the range of points. The file should transfer.
Data Transfer



TDS

This command applies to TDS data collectors.

Downloading (HP-48 and Husky)

1.
2.
3.
4.

In the TDS program, run the File Transfer command.
Choose the type of data to transfer (CRD or RAW) and pick the Send function key.
In Carlson X-Port, pick Data Collectors in the Tools menu then pick TDS.
Make sure that the COM port and baud rate are set correctly, then pick the Download
button.
5. While the program waits to receive the TDS file, you have 10 seconds to select the file
to send from the TDS program.
6. When the file transfer is complete, the command will ask you for the file to create unless
you already specified a file name in the dialog box.

Downloading (Ranger and Windows CE)

1.
2.
3.
4.
5.
6.

In the TDS program, run the Transfer command and pick the Send File function.
Set the "Connecting To" field to HP-48.
Make sure that the COM port, baud rate, and parity are set correctly, then pick OK.
In the Type field of the file selection dialog box, choose Coordinate Files or Raw Files.
In Carlson X-Port, pick Data Collectors from the Tools menu, then pick TDS.
Make sure that the COM port and baud rate are set correctly, then pick the Download
button.
7. While the program waits to receive the TDS file, you have 10 seconds to select the file
to send from the TDS program.
8. When the file transfer is complete, the program will ask you for the file to create unless
you already specified a file name in the dialog box.

Uploading (HP-48 and Husky)

A Carlson X-Port coordinate file can be converted to a CR5 file and uploaded into TDS.
1. Start in the TDS program File Transfer command.
2. Pick Data Collectors from the Tools menu, and choose TDS.
3. In the TDS Data Collection dialog box, enter a TDS File name. This name should not
include the drive and directory path or file extension. For example, if the CRD file is
c:\data\simo2.crd, then the TDS File name could be just SIMO2.
4. Next pick the Select File button next to the CRD File edit box and choose the CRD file to
send.
5. Check that the COM port and baud rate are set correctly.
6. Press the Upload button.
7. In the dialog box that appears, specify the range of point numbers to upload.
8. Enter the range of points, but before clicking the Start Transfer button, go to TDS and
press the Receive function key.
9. Within 10 seconds go back to Carlson X-Port and click the Start Transfer button on the
range of points dialog box. The file should then transfer.
Uploading (Ranger and Windows CE)

A Carlson X-Port coordinate file can be converted to a CR5 file and uploaded into TDS.
1. Start in the TDS Transfer command, and pick the Receive File function.
2. Set the "Connecting To" field to HP-48.
3. Make sure that the COM port, baud rate, and parity are set correctly and pick OK.
4. In Carlson X-Port, pick Data Collectors from the Tools menu then pick TDS.
5. In the TDS Data Collection dialog box, enter a TDS File name. This name should not
include the drive and directory path or file extension. For example, if the CRD file is
C:\data\simo2.crd,
6. then the TDS File name could be just SIMO2.
7. Pick the Select File button next to the CRD File edit box and choose the CRD file to
send.
8. Check that the COM port and baud rate are set correctly.
9. Pick the Upload button.
10. A dialog box allows you to specify the range of point numbers to upload.
11. Enter the range of points and click the Start Transfer button.

Data Transfer



Topcon

This command applies to the following Topcon total stations:
210
310
220
GPT2000

Import Raw Data

These commands convert raw data from other formats into the current Edit-Process RW5 file.
The converted raw data will be added to the end of the existing data in the current RW5 file. In
many cases, the raw file to import can be downloaded directly from the data collector or
instrument using the appropriate Data Collector command. In other cases, the file to import is
the output from another software program.
The following formats are supported:
•
•
•
•
•
•
•
•
•
•

C and G
CAiCE (Caltrans raw format only)
Carlson (*.rw5)
TDS (.rw5)
Fieldbook (.fbk)
Geodimeter (.obs or .raw)
Leica (.gsi or .raw)
Nikon (.trn or .raw)
SMI (.raw)
Sokkia/SDR (.raw or .sdr)

Export Raw Data

These commands export raw data from the editor to the following formats.
•
•
•

Sokkia/SDR: (.raw)
Fieldbook: (.fbk)
CAiCE (Caltrans raw format only)

Import Point Data



Text/ASCII File

The Import Point Data dialog box allows you to convert point data from an ASCII text file into
the current coordinate file (.CRD). Each line of the text file can contain any combination of point
number, northing, easting, elevation, and description. All of the information for a point should
be on one line with the values separated by a comma, space, or other delimiter.

•
•
•
•

Select Text File - You must select a text file to read into a coordinate file. The selected
file is displayed in the PreviewWindow to help you fill out the Coordinate Order.
Common Formats - This is a listing of common formats. Choose the format that matches
the ASCII file you are importing. When you choose a format, it will be copied to the
Coordinate Order edit box.
Coordinate Order - The format of the text file here is specified in the Coordinate Order
field where the value identifiers are listed with the appropriate delimiters
Press OK to start the import process. After it completes, you will receive the following
dialog to confirm success.

Import Point Data



Geodimeter

Allows you to select an .obs or .raw Geodimeter file to read into the CRD file.
Import Point Data



Leica

Presents the dialog shown below so that you can select the appropriate Leica coding system.
After pressing OK, a standard file dialog appears. Select the .gsi or .raw file to import.

Import Point Data



Sokkia/SDR

Allows you to select an .sdr or .raw file to read into the CRD file.
Import Point Data



TDS/CR5

Allows you to select a .cr5 file to read into the CRD file.

Export Point Data



Text/ASCII

The Export Text/ASCII File dialog box allows you to output point data from the current
coordinate file to an ASCII text file.

•
•
•
•
•

Coordinate Order - You select the type of file you want to write. You can choose from
among several variations on point number, northing, easting, elevation, and
descriptions.
Type of Delimiter - Choose type of delimiter, comma or space.
Number of Decimals - Choose the precision for the exported coordinates.
Range of Points - Specify the range of point numbers to export
OK - Presents a standard file dialog where you must specify the file name for the
exported file.

Export Point Data



Geodimeter

Allows you to specify a file name for Geodimeter export (.obs file format).
Export Point Data



Leica

Allows you to specify a file name for Leica export (.gsi file format). Then the dialog shown in
below will appear where you can specify the unit of measurement and the file format.

Export Point Data



TDS CR5

Allows you to specify a file name for TDS export (.cr5 file format).

Direct Reverse Report

This command allows you to analyze angle sets and produce a report of the results.

Cut Sheet

This command creates a report of the elevation difference between points and a design
elevation, which can be defined by other points in the current CRD file or points in another
CRD file.
Example 1 - Comparing points in the same CRD file.
The first dialog box shown below allows you to select the Current Coordinate File containing
the source points for comparison. Press OK to continue.

The next dialog box shown below is where you must specify the range of survey points, range
of design points, and the precision.

The next dialog is shown below allows you to specify the fields that you want to see in the
report and their order. Use a 0 (zero) to exclude a field.

Example 2 - Comparing points from two different CRD files

The first dialog box shown below allows you to select Another Coordinate File containing the
source points for comparison. Press OK to continue.

Next, a standard file dialog lets you select another CRD file for comparison. The next dialog
shown below allows you to specify the range of points to compare, and the precision. In this
example, we are comparing all the points. Press OK to continue. Configure the fields in the
following dialog box and select OK to generate the cut sheet report.

Scale Point Data

This command allows you to scale points in the current coordinate file. The northing, easting,
and elevation are scaled based on the settings you specify in the dialog shown below. Choose
the units of your source points and the units of the destination points and press OK.

Edit Field Code List

This command allows you to edit the field code list for use in SurvCE/G2 or the SDR33. The
main dialog is shown below.

•
•

Load - Used to load an existing Field Code List (.fcl file format)
Edit - Used to edit an existing field code. Highlight a code and press Edit to get the
dialog shown below. You can edit the code, the full name, and the entity type. Press OK
to accept the changes.

•

Add - Used to add a field code to the list. When you press Add, you will get the same
dialog as shown above, except all the fields will be blank. Enter the necessary data and
press OK.
Remove - Used to remove a code from the list. Highlight a code and press Remove. The
item is removed immediately.
Save - Saves the currently loaded file.
Exit - Exits the Field Code List editor.

•
•
•

Convert DXF to FLT

Creates a Carlson triangulation file (*.FLT) from any DXF file containing a TIN where the
triangle entities are 3D Faces.
Convert Section Data



Import IGRDS Section

Creates a Carlson section file (*.SCT) from an IGRDS section file.
Convert Section Data



Export IGRDS Section

Creates an IGRDS section file from a Carlson (*.SCT) section file.

Format of the Raw File (.RW5 extension)

The following are supported record header codes with their field headers:
-AB
BC
BK
BP
BS
CL
DS
E
EL
FP
HI
HR
LS
N
OP
PN
SP
SS
TR

Point Description/Note
Angle Balance Record
Back Circle
Backsight
Backsight Point Number (if 0 the next field’s azimuth will be used for)
Back Azimuth
Closure Record
Description
East Coordinate
Elevation
Foresight Point Number
Height of Instrument
Height of Rod/Target
Line of Sight
North Coordinate
Occupy Point Number
Point Number
Store Point
Side Shot
Traverse

Measurement Record – Horizontal (one of the following 6)
AL
AR
AZ
BR
DL
DR

Angle Left (angle code 6)
Angle Right (angle code 7)
Azimuth (angle code 5)
Bearing (angle code 1 = NE, 2 = SE, 3 = SW, 4 = NW)
Deflection Angle Left (angle code 8)
Deflection Angle Right (angle code 9)

Measurement Record - Vertical (one of the following 3)
CE
VA
ZE

Change/Difference in Elevation from Instrument Point
Vertical Angle (0 degrees level)
Zenith Angle (90 degrees level)

Measurement Record - Distance
HD
SD

Horizontal Distance (if CE above)
Slope Distance (if ZE or VA above)

